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17. OCEAN COLOUR MEASUREMENTS OF THE 
PRODUCTIVITY IN THE BENGUELA CURRENT 
LARGE MARINE ECOSYSTEM 

By: Deon Louw1 and Valborg Byfield2 

17.1. Introduction and relevance of application 

The Namibian coastline is about 1500km long with five coastal towns of which Walvis Bay and Lüderitz are the only 
two harbour towns. The entire coastline is relatively straight and unprotected, and strongly influenced by the cold 
Benguela Current flowing northwards. A major influence on the ecology of the region is the coastal upwelling of 
water from the shelf slope, caused by the long-shore wind regime.  Strong southerly winds drive an offshore flow of 
coastal water, which is replaced by cold, nutrient-rich water from the continental slope.  The high nutrient content 
gives rise to high primary productivity and supports rich commercial fisheries. The cold, productive upwelling water 
displays strong seasonal, interannual and decadal variability, which can easily be observed in satellite measurements 
of sea surface temperature (SST) and ocean colour.   
Variation in fish recruitment growth and distribution is largely dependent on environmental conditions.  
Understanding the relationship between environmental variability, primary productivity, recruitment and abundance 
of commercially important fish species is necessary for ecosystem-based fisheries management.  There is a lack of 
direct measurements of upwelling strength and phytoplankton production.  However, marine ecologists in Namibia 

have over the past years developed a number of indirect indices; these include sea surface temperature (SST) and 
chlorophyll concentrations, wind speed and direction, and estimates of offshore transport of cold upwelling water.  
Much of the data used to develop these indices may be sourced from the Internet; this includes scatterometry wind 
data, low resolution chlorophyll-a concentrations from NASA MODIS and SeaWiFS, global SST from NCEP and 
Pathfinder. Higher resolution (1km) chlorophyll-a and SST are available through the DevCoCast channel on 
GEONETCast.   
Namibia runs an intensive oceanographic monitoring programme, which relies on shipboard measurements of 
temperature, salinity and chlorophyll concentrations. Selected transects are monitored on a monthly/bi-monthly 
basis and the in situ measurements from these cruises can be used in conjunction with satellite data. The synoptic 
view of satellites makes it possible to detect fronts, upwelling filaments, plankton blooms, monitor the strength and 
extent of the coastal upwelling and detect intrusions of warm water from the boundaries of the system.  The in-situ 
data taken at the surface provides a control on the satellite measurements and furthermore gives 3-dimensional 
information of the system.  

17.2. Objective of the application 

This application compares in situ measurements from one of the Namibian monitoring transects with 1 km spatial 
resolution satellite data of chlorophyll and sea surface temperature (SST) to assess the strengths and limitations of 
using satellite measurements of chlorophyll and SST to monitor primary productivity in the Benguela upwelling 

system. 
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17.3. Study Area 

The Benguela system is one of the four major eastern boundary upwelling systems of the world. It spans three 
countries on the west coast of Africa from about 14°S in Angola, through the entire coast of Namibia to about 37°S 
off the southern tip of Africa. Figure 17.1 (after Hardman-Mountford et al., 2003) shows a schematic of the 
oceanography in the region.  The Benguela system is the only eastern boundary upwelling system that is bounded by 
warm water at both ends: the warm Angola Current and Angola Dome to the north and the warm Agulhas Current 

in the south and east.   

Figure 17.1 Currents and upwelling cells in the Benguela system 
 
The cold waters of the Benguela Current itself originate in the Southern Ocean.  The Benguela system has several 
‘upwelling cells’ – regions where a change in the orientation of the coastline creates cyclonic wind-stress curl.  The 
strongest of these is the strong Lüderitz cell in central Namibia, which divides the system into two.  The northern 
Benguela shelf is a typical coastal upwelling system with equator ward winds, cool water, high plankton biomass and 
moderate to high fish biomass, which is currently in a depleted state. Widespread oxygen-depleted waters and 
sulphur eruptions restrict the habitat available for fish. The focus of this study is the upwelling cell near Walvis Bay, 
from the coast to a distance of 200-250 km – the maximum seaward extent of most upwelling filaments.  
A typical feature of the central Namibian coastal ocean are the banks of fog that form when warm air from the 
Namib Desert flows seaward and cools as it crosses the cold Benguela Current.  The location of these fog banks may 
vary, but it is often found in association with the coldest water of the central upwelling cells.  The fog may prevent 
satellite measurements at visible and near infrared wavelengths.  When less dense, it may not fully prevent 
measurements, but can still create problems for accurate atmospheric correction of ocean colour data.   
Three other upwelling-related phenomena may also prevent accurate atmospheric correction and subsequent 
calculations of chlorophyll concentration: 
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 The intensity and high particle scattering of some upwelling blooms can produce high signal returns in the 
near infrared channels used to calculate the various parameters used for atmospheric correction. When 
this occurs, there may be an over-correction in the visible channels, or a failure to establish the spectral 

characteristics of the aerosol contribution.  Since chlorophyll concentrations are typically calculated from 
spectral ratios in blue and green channels, this will produce over-or under-estimates of chlorophyll, 
depending on the exact nature of the problem.   

 ‘Sulphur eruptions’ from low oxygen regions of the sea floor have a similar effect to that of very high 
concentrations of plankton cells, by producing highly scattering ‘white’ water. 

 Finally dust plumes from the Namib Desert produce absorbing aerosols that also create difficulties with 
establishing the spectral characteristics of the aerosol contribution and therefore reduce the accuracy of 
the atmospheric correction. 

17.4. Data used for the study 

17.4.1. Local in-situ data 

In-situ measurements of upwelling diffuse attention, Ku440, chlorophyll-a, and temperature from two dates in 2009 
were selected for use in the exercise.  The first data set, from 1 April represents upwelling and bloom conditions 
during late summer; the second, from 20 August, were obtained during a winter period when the water was 
homogenously mixed. The in-situ data for this exercise from the 20th of August is shown in table 17.1. These samples 
were taken on stations from inshore to offshore along the 23.00 ºS line in Namibian waters off Walvis Bay.  
 

Date Satellite 
Time 

In-situ 
Time 

Time 
Difference

Latitude Longitude Station 
(nm)

In-situ 
SST 

In-situ  
Chl-a

20/08/2009 12:55 12:07 -00:48 -23.00 14.37 2 12.08 4.00 
20/08/2009 12:55 13:10 +00:15 -23.00 14.32 5 12.23 4.00
20/08/2009 12:55 14:23 +01:28 -23.00 14.23 10 12.56 4.41 
20/08/2009 12:55 16:20 +03:25 -23.00 14.05 20 13.08 2.35
20/08/2009 12:55 17:59 +05:04 -23.00 13.86 30 13.30 2.47 
20/08/2009 12:55 19:37 +06:42 -23.00 13.69 40 13.12 3.70 
20/08/2009 12:55 21:25 +08:30 -23.00 13.51 50 13.35 1.88
20/08/2009 12:55 23:05 +10:10 -23.00 13.33 60 13.55 2.70 
21/08/2009 12:55 01:45 +12:50 -23.00 13.15 70 13.72 2.35

Table 17.1 In-situ sampling satellite overpass times for the match-ups used in the exercise 

17.4.2. Satellite data 

The study uses 1 km spatial resolution MODIS-Aqua ocean colour and sea surface temperature (SST) data of the 
Namibia region, processed by the Plymouth Marine Laboratory (PML), which is available through the DevCoCast 
channel on GEONETCast.  The data sets include level 2 processing flags, which are important for selection of valid 
chlorophyll concentrations.  Two different days were chosen: the first shows an upwelling event centred on 29 
March 2009 (late summer) and clearly illustrates some of the atmospheric correction issues associated with fog and 
very high plankton concentrations; the second, from 20 August, 2009 (southern winter) represents less problematic 
conditions and a reasonable match-up with in-situ chlorophyll and SST measurements from the Namibian monthly 
monitoring programme.  

17.5. Methodology and data pre-processing 

A flowchart of the overall methodology is provided in the figure below. Yellow squares indicate steps carried out in 
BILKO (http://www.noc.soton.ac.uk/bilko/index.php), green steps carried out in ILWIS, and blue steps carried out 
in Excel. 
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Figure 17.2 Flowchart showing the key data selection and processing steps  

17.5.1. Selection of satellite and in-situ match-ups 

Figure 17.2 also gives an overview of the data selection and pre-processing steps.  Satellite data are selected for dates 
corresponding to the Namibian in-situ monitoring programme along 23°S.  Initial cloud free scenes from these dates 
are identified based on web-archives of browse-images.  A further sub-selection was based on the time difference 
between satellite overpass time and the closest set of in situ measurements.  

17.5.2. In-situ data pre-processing 

Chlorophyll-a and temperature data is collected on the 23º00S line off Walvis Bay in Namibian waters in 2009 at 
different stations from inshore to offshore (2nm, 5nm, 10nm, 20nm, 30nm, 40nm, 50nm, 60nm and 70nm). Not all 
station measurements were done during the daytime (see table 17.1). 

17.5.2.1. Chlorophyll-a measurements 

Sea water samples for chlorophyll-a are taken at different depth, close to the surface and approximately at 10m, 20m 
and 30m depth and filtered on a GF/F filter. In the laboratory, chlorophyll-a was determined fluorometrically, after 
extracting it for 24 hours in the dark at -20ºC in 90% acetone. The Welschmeyer method was used to determine the 
fluorescence and chlorophyll-a concentrations was calculated as µg/l using the calibration factor obtained through 
preparing a set of dilutions and calculating the slope of the fluorometer readings versus chlorophyll-a concentrations. 

17.5.2.2. Temperature measurements 

A Sea-Bird CTD (Conductivity-Temperature-Depth) mounted on a SBE32 12-position rosette was deployed at the 
stations at a descent rate of 1m/s to within 10m of the seabed. Through the SBE 11 deck unit and the Sea-Bird 
software four files are produces, namely a data file (DAT), a header file (HDR), a configuration file (CON) and a 
mark file (MRK), which are saved for further processing. 
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17.6. Satellite image processing 

Visual screening of the 29 March chlorophyll data, using BILKO1 (figure 17.3) shows clearly that some of the pixels 
contain invalid data, which must be masked. Anomalously low chlorophyll values in (A) are likely to be the result of 
fog; in (B) the atmospheric correction has most likely failed due to scattered cloud or the intensity of the plankton 
bloom or a combination of both. 

Figure 17.3 Chlorophyll data for Namibia displayed in BILKO.   

17.6.1. Creating a mask using BILKO software 

Algorithms used to calculate chlorophyll-a from MODIS measurements are based on assumptions that do not always 
hold in highly productive regions such as the Benguela.  During processing from level 1 to level 2 confidence flags 
are raised when these assumptions are violated.  When a flag is raised, data in the corresponding pixel location must 
be considered less accurate or even invalid, depending on the seriousness of the problem.  In some cases flagged 
pixels may still be useful, particularly when used with in-situ data that can provide independent verification, but care 
must be taken to check that spatial patterns are compatible with what would be expected from marine dynamics 
(currents, eddies, upwelling filaments, fronts, river plumes) in the region of interest.  For the 1st April image a mask 
was created from selected flags, using the BILKO software and a bit-mask formula based on the flag values (figure 
17.4)2.  The mask was saved in GeoTiff format for import into ILWIS (see also figure 17.5). 

                                                      
1 Bilko can be downloaded by registered users from the Bilko web site at www.bilko.org.  A detailed lesson explaining the level 2 processing 

flags, the thinking behind the Bilko formula document used for the masking process, and hints on how to recognize the spatial patterns 

characteristic of invalid data may be found at http://www.noc.soton.ac.uk/bilko/eamnet/ 
2 A detailed lesson describing the process of selecting suitable flags has been developed for the DevCoCast sister-programme EAMNet, and may 

be found on the Bilko web site at www.bilko.org/eamnet/ 
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Figure 17.4 BILKO 'formula' to create a mask from selected MODIS flags 

Figure 17.5 Original chlorophyll data (left) and after application of the mask with coastline and borders 
superimposed (right) imported in ILWIS 

17.7. Comparing satellite and in situ data 

Unzip the exercise data into your working directory. Here “C:\Data\Benguela” is used. Open ILWIS and navigate to 
this directory. Close ILWIS and open it again. The ILWIS catalogue should now show the content of the active 
working directory. Note that for this exercise all data needed still has to be imported. 

17.7.1. Obtaining satellite-equivalent chlorophyll values from the in-situ measurements 

In situ measurements of chlorophyll-a are made at different depths.  From this it is necessary to calculate ‘satellite 
equivalent chlorophyll’ – the signal ‘seen’ by the satellite. According to bio-optical theory, 90% of the water leaving 
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signal in Case 1 waters1 comes from first optical depth i.e. 1/Kd490.  This means the Kd490 data provided by 
MODIS may be used to decide on how to calculate satellite equivalent chlorophyll.  In clear open ocean waters, with 
very low concentrations of plankton cells in surface layers, the one optical depth can be several 10s of metres; in 

productive systems such as the Benguela it may be 5-10 m and sometimes less. 
On 1 April satellite Kd490 values in the region of interest ranged from 0.2 to over 2.5 m-1. One optical depth 
(1/Kd490) was thus between 0.4 m and 5 m.  In-situ measurements of upwelling diffuse attenuation at 440nm 
(Ku440) were comparable, (0.5 - 1.3 m-1, optical depths 0.7 - 1.9m).  Chlorophyll data from the deeper samples (10m, 
20m and 30m) therefore contributed only 0.5 - 5% to water-leaving radiance, and could thus be considered 
irrelevant2.  Unfortunately no chlorophyll samples were taken near the surface.  For this reason, and due to the 
problem with satellite data quality discussed in section 1.6, satellite - in situ comparison will only be carried out for 20 
August, when in situ Ku440 ranged from 0.18 to 0.31 m-1, (optical depths: 3.1 - 5.6 m) and vertical profiles of 
temperature and chlorophyll revealed a well-mixed water column.  Average in situ chlorophyll concentrations used 
for the comparison are given in Table 17.1 above. 

17.7.2. Importing the 20 August chlorophyll-a map in ILWIS 

The PML MODIS data comes in NetCDF format, which contains normalised water-leaving radiances at different 
wavelengths, nLw_*, chlorophyll concentrations, chlor_a, and diffuse attenuation at 490 nm, Kd_490.  These sub-
datasets can be extracted using the GEONETCast Toolbox before you can display them in ILWIS.  Another way to 
do this is using the DOS Command Prompt, which can be opened from the Accessories folder of the Program 
menu.   
In the Command window, navigate to your working directory which contains the exercise data.  In the figure 17.6 
example, the data is kept in “C:\data\benguela”; note that you may have the data in a different directory. 

Figure 17.6 Command Prompt window showing navigation to the file containing the Benguela images 
 
To check the content of the NETCDF files, type this command:  
  

“C:\ilwis372_SEBS\Extensions\Geonetcast-Toolbox\GDAL\bin\gdalinfo.exe” 

PML_Namibia_MODIS_oc_refined_20090820135500.nc 
 
Note that in this example “C:\ilwis372_SEBS\” is used because the ILWIS software in installed directly on the C:\ 
drive in the folder “ilwis372_SEBS”.  If you have ILWIS installed in a different location you must use that. Press 
return to run the “gdalinfo.exe” application and take note of the listing of the content of the file 
“PML_Namibia_MODIS_oc_refined_20090820135500.nc”. Note the names of the different sub-dataset; you will need 
these in the next step.  Also see appendix 1 for the file content listing. 
To import a sub-dataset into ILWIS you use “gdal_translate.exe” from the Geonetcast Toolbox.  For example, to 
import  SUBDATASET_8  “chlor_a” you type the following command:  
 

“C:\ilwis372_SEBS\Extensions\Geonetcast-Toolbox\GDAL\bin\gdal_translate.exe” -of ILWIS 
NETCDF:"PML_Namibia_MODIS_oc_refined_20090820135500.nc":chlor_a 20090820_chlor_a.mpr 

                                                      
1 In Case 1 waters the optical characteristics are determined only by the optical properties of water, phytoplankton and associated plankton 

breakdown products, which are correlated with plankton concentrations.  This contrasts with Case 2 waters, where optical properties also depend 
on concentrations of suspended sediment and coloured dissolved organic matter that enters the ocean from land, for example via rivers.   
2 On one station, no surface sample was taken, but the in situ measurements of temperature revealed a well mixed water column, so it was 

reasonable to assume that using an average in situ chlorophyll could be used for comparison with the satellite data. 
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This will run “gdal_translate.exe” (found in the GDAL\bin directory of the Geonetcast Toolbox) to extract the sub-
dataset named “NETCDF:"PML_Namibia_MODIS_oc_refined_20090820135500.nc":chlor_a”.  The output file is 

“20090820_chlor_a.mpr”.  The expression “-of ILWIS” between the program and the image to be extracted specifies 
the output file format, here an ILWIS format is used. Execute the expression to import the chlorophyll-a map, an 
example is provided in figure 17.7 as well.   
 

Figure 17.7 Import of SUBDATASET_8 (chlor_a) into ILWIS 
 
After import, return to ILWIS, refresh the catalogue (select from the main ILWIS menu the option “Window” > 
“Refresh”) and select the GeoReference created, called “20090820_chlor_a” having the following icon: . Right click 
the icon with the mouse, from the context sensitive menu select the option “Properties” and change the coordinate 
system from “Unknown” to “LatlonWGS84” and press “OK” (see figure 17.8). 

Figure 17.8 Changing the GeoReference information. 
 

Double click with the mouse the map “20090820_chlor_a” to open it. You can change the colour of the map using a 
Representation; here you can use the Representation “Pseudo”. For the chlorophyll-a map select a “logarithmic” stretch 
with the maximum set to “100”, and click “OK”.  To add the boundaries for Namibia, select from the active map 
display window the option “Layers” > “Add Layer” and navigate to your ILWIS directory and select from there the 
sub-directory “\Extensions\Geonetcast-Toolbox\util\maps”, then select the vector map “Africa_country”.  In the 
subsequent Display Options dialog window check the box for “Boundaries Only” and uncheck the box “Info”. You can 
change the boundary colour to “Black”. The result should look similar to that of figure 17.9. 
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Figure 17.9 Chlorophyll-a map of the Benguela region with coastline and borders superimposed 

17.7.3. Import of In Situ sampling points and creating a Point Map 

17.7.3.1. Import of the In Situ observations 

Open from your working directory the file “in_situ.txt” by double clicking on it. There are 9 relevant records for the 
following attributes: latitude, longitude, distance in nautical miles, sea surface temperature, chlorophyll-a and the 
station name (see also table 17.1). To import this text file and create an ILWIS table conduct the following operation. 
Open from the main ILWIS menu the option “File” > “Import” > “ILWIS” > “Table” > “Space Delimited”, as input 
file select “in_situ.txt” and as output file specify “station_data” and press “OK” and “Next”. In the Edit Column 
Details window specify the settings as given in the figure below and press “Finish” and “OK”. Note that the Domain 
Type should be correctly specified, using a “value” domain, except for the column ‘st_name’, which is having a 
“string” domain. 

 Figure 17.10 Table column import settings 
After import open the table “station_data” and inspect the content. Note that there are two records, having as name 
‘Base’ and ‘Return’, these are marking the start and end of the section. Close the table. 

17.7.3.2. Creating a Point Map 

From the main ILWIS menu, select “Operations” > “Table Operations” > “Table to PointMap”. In the dialog window that 
opens choose as input the “Station_data” table.  The XY column (Coords) are automatically assigned, coordinate 

system is “LatlonWGS84”; as output point map use the name “station_data”, keep the other settings default and press 
“Show” and “OK”.  
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Return to the chlorophyll map you opened earlier.  To overlay the point map on this raster image, select “Layers” > 
“Add Layers” from the map display menu, and choose the newly created point map.  The Display Options dialog 
allows you to select how the points are displayed.  Check the Single Symbol box, and click on the tab to open the 

Symbol dialog. Choose from the option Symbol and select “Square”, using a symbol size of “3”, set the Fill Color to 
“Black” and press “OK” twice.  You should now see the points on the chlorophyll map (figure 17.11).  Use the zoom 
tool to get a better view of the sampling region. From the active map window select the option “File” > “Open Pixel 
Information” and move the mouse cursor over the sampling locations, check the map and table values! 

Figure 17.11 The chlorophyll-a image with the point map overlaid 

17.7.4. Extracting satellite data for statistical analysis 

Before you can extract the information of the chlorophyll map you first have to rasterize the point map. From the 
main ILWIS menu, select “Operations” > “Rasterize” > “Point to Raster”, as point map select “station_data” and as 
output map leave the default name “station_data”, as georeference select “20090820_chlor_a” and press “Show”. In the 
new map display window, select from the menu “Layers” > “Add Layer” and select the “station_data” point map. 
Zoom in on the observation locations to see the result of the operation. 
Now select from the main ILWIS menu the option “Operations” > “Raster Operations” > “Cross”. As 1st map select 
“station_data” and as 2nd map the “20090820_chlor_a” map. Specify as output table name “st_chlora” and press “Show”. 
Check the results given in the new table. For the sampling locations (except the ‘Base’) the chlorophyll-a values are 
extracted. 
Open the table “station_data”, from the main table menu, select the option “Columns” > “Join”, in the next ‘Join 
Wizard – Select input table and column’, select as input table “st_chlora” and as input column “20090820_chlor_a”, 

press “Next” three times, using the default settings, also the default output column name can be accepted and press 
“Finish” and “OK”. Inspect the content of the table and check the new column added. 
To check the correlation between the in situ and satellite derived chrolophyll-a values, select from the table menu the 
option “Columns” > “Statistics”, as function select “Correlation” and as columns use “chlor_a” and “20090820_chlor_a” 
and press “OK”. What can be concluded? 
Select from the Table menu the graphics icon , and from the “Create Graph” menu, select as X-axis “chlora” and as 
Y-axis “20090820_chlor_a”. Press “OK” to display the graph. You can modify the Graph properties by selecting the 
items in the left hand graph legend. E.g. unselect “Legend” and for the item ”chlora*20090820_chlor_a”, by double 
clicking with the mouse on the item name, use as “Color” “Red”. Also change the Min-Max settings of the graph axis 
(X: from 0 to 5, interval of 0.5 and Y: from 0 to 5, interval 0.5). Proceed from the active Graph window, select from 
the menu “Edit”, “Add Graph” and select “Least Square Fit”. Select as X-column “chlora” and as Y-column 
“20090820_chlor_a”, use as Function “polynomial” with “2” terms (1st order polynomial function) and press “OK”. 
From the Graph legend, select the item: “chlora*20090820_chlor_a - polynomial”, change the Color to “Black” and set 
the Line Width to “0.2”. Also note the regression formula, which is given on the lower left hand of this menu. Press 
“OK”. Your results should resemble those of figure 17.12. 
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Figure 17.12 Scatter plot showing relationship 
 
Close the graph window, eventually save the graph (select from the graph menu the option “File” > “Save”). Activate 
the table “station_data” again and from the table menu select “Column”, “Least Squares” and for the X-column select 
“chlora” and the Y-column “20090820_chlor_a”, specify as output column “Calculated”. Use as function “Polynomial” as 
number of terms “2” and press “OK” to execute the operation. In the column properties window select the option 
“Additional Info”, here the function is given, leave the other options as default and press “OK”. A new column, called 
“Calculated” is now added to the table. Check the results obtained in the table and compare the differences between 
the observed, satellite derived and values obtained using the regression function.  

17.7.5. Characterising chlorophyll variability in spatial windows around the sampling points 

The ocean environment is highly dynamic and phytoplankton distributions are ‘patchy’ – that is highly variable over 
fairly short spatial and temporal scales.  These patches drift, with currents and eddies, and may move by distances 
greater than a single pixel over a period of a few hours.  For this reason it is not sufficient to compare the in-situ 
measurements to satellite data at a single point.  You also need to characterise the spatial variability around each 
location.  This may be done by selecting spatial windows of increasing size, centred on the pixel containing the 
sampling location. The mean or median chlorophyll concentrations, along with the standard deviation (or variance) 
needs to be calculated for several windows of increasing size (e.g. 3x3, 5x5, 7x7, even 9x9) around each sampling 

point. This process requires three steps before you can export the data for statistical analysis. Here only the average 
and median spatial variability are considered to serve as an example of the procedures to be followed. 

17.7.5.1. Step I. Filtering  

From the main ILWIS menu select the option “Operations” > “Image Processing” > “Filter”. In the Filter dialog set the 
filter type to “Average”.  The rows and columns should change to 3x3; accept this.  Specify as input map 
“20090820_chlor_a” and enter an appropriate name for the Output Raster Map. Note: it is important to choose a 
name which you will recognise immediately, because you need to make several maps, e.g. ‘chlor_a_3_avg’ and 

‘chlor_a_3_med’, etc. Change the Precision to three digits, and click “Show”. To create the other filtered maps you 
can simply repeat the procedure and change the dimension of the filter kernel size (e.g. to 5 by 5). Repeat the 
procedure also for the 5x5, 7x7 and 9x9 average filter sizes. For median filtering, select as filter type “Median” and 
also create these maps using different filter sizes. Note that various other filters are at your disposal and if required 
you can create them yourselves, consult also the ILWIS Help if more assistance is needed. 

17.7.5.2. Step 2. Create a Map List 

From the main ILWIS menu select the option “File” > “Create” > “Map List”. In the Create MapList window enter a 
name for the new Map List, e.g. “avg”.  Select the different filtered raster images maps created by the average filtering 
in sequential order and move them to the right pane by clicking the “>” tab between the panes. Click “OK”.  Repeat 
this procedure to create the Median filtered maps and call this map list “med”. 



APPLICATION MANUAL 

174 

17.7.5.3. Step 3. Creating a Table from a Map List 

From the main ILWIS menu, select the option “Operations” > “Point Operations” > “Point Map Cross”. In the Point 
Map Cross dialog select again the point map that contains the in situ stations, here called “station_data”. Choose the 
Map List “avg” you have just created in step 2 above, specify as output point map “avg” and press “Show” to execute 
the operation. You can close the newly created point map, open the newly created table “avg”. Repeat the procedure 
for the median filtered map list and call the output point map “med”. Open both tables you have just created and 
inspect the values of the different windows around your sampling point. For further analysis you can copy the values 
with station data into an Excel spreadsheet.  

17.8. Statistical Analysis of the match-up data 

The data extracted is summarised in the table below, which also includes the average in-situ chlorophyll.  Statistical 
analysis may now be done in Excel, R or another suitable statistical package and will typically include plotting in situ 
chlorophyll-a against the satellite-derived concentrations as demonstrated above (see figure 17.12).  More detailed 
analysis is outside the scope of this exercise.  
 

Station in situ 
chlor_a 

Modis 
avg 3x3 avg 5x5 avg 7x7 avg 9x9 med 3x3 med 5x5 med 7x7 med 9x9 

ww23002 4.0 4.769 4.769 3.062 3.235 3.343 2.933 2.958 2.991 2.933 

ww23005 4.0 2.862 2.862 2.817 2.824 2.826 2.715 2.715 2.819 2.715 

ww23010 4.41 2.715 2.715 1.302 1.321 1.351 1.265 1.299 1.316 1.265 

ww23020 2.35 1.216 1.216 1.177 1.2 1.237 1.186 1.188 1.194 1.186 

ww23030 2.47 1.267 1.267 1.661 1.62 1.617 1.647 1.63 1.609 1.647 

ww23040 3.7 1.795 1.795 1.664 1.573 1.541 1.686 1.588 1.562 1.686 

ww23050 1.88 1.761 1.761 2.388 2.264 2.11 2.448 2.168 2.004 2.448 

ww23060 2.7 2.456 2.456 1.904 1.827 1.837 1.878 1.799 1.835 1.878 

ww23070 2.35 2.103 2.103 2.015 2.001 1.928 1.956 1.956 1.937 1.956 

Table 17.2 In situ average and satellite derived chlorophyll for various match-up windows 
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17.9. Processing the SST data 

In your directory also a NETCDF file is available providing the satellite derived sea surface temperature (SST). 
Repeat the steps described before and analyse the in situ and satellite derived sea surface temperatures. First inspect 
the file using ‘gdalinfo’ and then import the file using ‘gdal_translate’. A sample import syntax string is provided 
below.  

 
“C:\ilwis372_SEBS\Extensions\Geonetcast-Toolbox\GDAL\bin\gdal_translate.exe” -of ILWIS 
NETCDF:"PML_Namibia_MODIS_sst_refined_20090820135500.nc":sst 20090820_sst.mpr 

 
Upon completion of the import right click with the mouse the newly imported map, here called “20090820_sst”, 
from the context sensitive menu select the option “Properties” and now select as georeference the one used for the 
chlorophyll-a map “20090820_chlor_a”. All other processing and analysis routines are identical to the procedures 
described above. If successful the results should resemble those provided in figure 17.13.  The satellite SST is 
consistently higher than the corresponding in situ temperature.  This is due to solar heating of the surface 'skin' of the 
ocean during the day.  Satellites measure the 'skin temperature' - the top mm of the water.  During the day this layer 

is heated by the sun, and becomes warmer than the underlying water.  In-situ measurements are made at depths of 1 
to 5 m. This 'bulk' temperature varies less between day and night than the 'skin' temperature seen by the satellite. The 
plot also shows that the location 2nm from the shore has a much greater difference between 'skin' and 'bulk' than 
indicated for the other 8 sampling points.  The reason for this may be 'land contamination' (radiation from much 
warmer land contributes to the signal) or, perhaps more likely, calmer near-shore conditions (calmer waters have a 
greater difference between 'skin' and 'bulk' temperatures). Removing this outlier makes the SST – in situ relationship 
linear. 

Figure 17.13 Results of the in situ and satellite derived SST comparison 

17.10. Concluding remarks 

Satellite measurements of ocean colour and sea surface temperature can provide valuable information about the 
dynamics of the Benguela coastal upwelling system.   However, care must be taken to identify artefacts in the satellite 
data and exclude these from the analysis.  The strength of satellite images lie in their synoptic view of the region and 
their regular repeated measurements, which make them a good tools for spatial and temporal variability and change 
in the region.  However, absolute values of chlorophyll and SST are less reliable. The examples shown here indicate 
that in-situ measurements are still needed to 'calibrate' the satellite measurements - particularly close to the coast, or at 
times of strong upwelling when the satellite measurements are more problematic. 
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APPENDIX 1 

File content listing of t he file PML_Namibia_MODIS_oc_refined_20090820135500.nc 
 

Driver: netCDF/Network Common Data Format 

Files: PML_Namibia_MODIS_oc_refined_20090820135500.nc 

Size is 512, 512 

Coordinate System is `' 

Metadata: 

  NC_GLOBAL#site_name=EAMNet: Namibia 

  NC_GLOBAL#citation=If you use this data towards any publication, please acknowledge this using: 'The authors thank 

the NERC Earth Observation Data Acquisition and Analysis Service (NEODAAS) for supplying data for this study' and 

then email NEODAAS (info@neodaas.ac.uk) with the details. The service relies on users' publications as one measure of 

success. 

  NC_GLOBAL#creation_date=Wed Aug 24 19:08:15 2011 

  NC_GLOBAL#easternmost_longitude=15.9969 

  NC_GLOBAL#creator_url=http://rsg.pml.ac.uk 

  NC_GLOBAL#references=See NEODAAS webpages at http://www.neodaas.ac.uk/ or RSG pages at 

http://rsg.pml.ac.uk/ 

  NC_GLOBAL#Metadata_Conventions=Unidata Dataset Discovery v1.0 

  NC_GLOBAL#keywords=satellite,observation,ocean 

  NC_GLOBAL#summary=This data is Level-3 satellite observation data (Level 3 meaning raw observations processedto 

geophysical quantities, and placed onto a regular grid). 

  NC_GLOBAL#id=M2009232.1255.y6.oc_products.MYO.20aug091255.v4.20112361807.data.nc 

  NC_GLOBAL#naming_authority=uk.ac.pml 

  NC_GLOBAL#geospatial_lat_max=-13.9976 

  NC_GLOBAL#title=Level-3 satellite data from Moderate Resolution Imaging Spectroradiometer sensor 

  NC_GLOBAL#source=Moderate Resolution Imaging Spectroradiometer 

  NC_GLOBAL#northernmost_latitude=-13.9976 

  NC_GLOBAL#creator_name=Plymouth Marine Laboratory Remote Sensing Group 

  NC_GLOBAL#processing_level=Level-3 (NASA EOS Conventions) 

  NC_GLOBAL#creator_email=rsghelp@pml.ac.uk 

  NC_GLOBAL#netcdf_library_version=4.1.1 of Dec  6 2010 08:20:12 $ 

  NC_GLOBAL#date_issued=Wed Aug 24 19:08:15 2011 

  NC_GLOBAL#geospatial_lat_min=-28 

  NC_GLOBAL#date_created=Wed Aug 24 19:08:15 2011 

  NC_GLOBAL#institution=Plymouth Marine Laboratory Remote Sensing Group 

  NC_GLOBAL#geospatial_lon_max=15.9969 

  NC_GLOBAL#geospatial_lon_min=4 

  NC_GLOBAL#contact1=email: rsghelp@pml.ac.uk 

  NC_GLOBAL#license=If you use this data towards any publication, please acknowledge this using: 'The authors thank 

the NERC Earth Observation Data Acquisition and Analysis Service (NEODAAS) for supplying data for this study' and 

then email NEODAAS (info@neodaas.ac.uk) with the details. The service relies on users' publications as one measure of 

success. 

  NC_GLOBAL#Conventions=CF-1.4 

  NC_GLOBAL#project=NEODAAS (NERC Earth Observation Data Acquisition and Analysis Service) 
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  NC_GLOBAL#cdm_data_type=Grid 

  NC_GLOBAL#RSG_sensor=MODIS 

  NC_GLOBAL#westernmost_longitude=4 

  NC_GLOBAL#RSG_areacode=y6 

  NC_GLOBAL#southernmost_latitude=-28 

  NC_GLOBAL#netcdf_file_type=NETCDF3_CLASSIC 

  NC_GLOBAL#history=Created during RSG Standard Mapping (MODIS-AQUA-NASA-refined-OC-mapper-

config.xml) 

1314211588 Subsetted from 

A2009232125500/products/devcocast/2009/08/20/M2009232.1255.y6.oc_products.MYO.20aug091255.v4.20112361807.

data.nc to only include variables 

nLw_547,nLw_412,nLw_488,nLw_667,Kd_490,nLw_531,l2_flags,chlor_a,latitude_longitude,longitude,time,latitude,nLw_4

43 

  NC_GLOBAL#RSG_hash_descriptor=openssl_sha1:1:52990df6ec7fb2ac2e13f515c4a4ffee1cbd83fb 

Subdatasets: 

  SUBDATASET_1_NAME=NETCDF:"PML_Namibia_MODIS_oc_refined_20090820135500.nc":nLw_547 

  SUBDATASET_1_DESC=[1x1557x1334] surface_upwelling_spectral_radiance_in_air_emerging_from_sea_water (32-bit 

floating-point) 

  SUBDATASET_2_NAME=NETCDF:"PML_Namibia_MODIS_oc_refined_20090820135500.nc":nLw_412 

  SUBDATASET_2_DESC=[1x1557x1334] surface_upwelling_spectral_radiance_in_air_emerging_from_sea_water (32-bit 

floating-point) 

  SUBDATASET_3_NAME=NETCDF:"PML_Namibia_MODIS_oc_refined_20090820135500.nc":nLw_488 

  SUBDATASET_3_DESC=[1x1557x1334] surface_upwelling_spectral_radiance_in_air_emerging_from_sea_water (32-bit 

floating-point) 

  SUBDATASET_4_NAME=NETCDF:"PML_Namibia_MODIS_oc_refined_20090820135500.nc":nLw_667 

  SUBDATASET_4_DESC=[1x1557x1334] surface_upwelling_spectral_radiance_in_air_emerging_from_sea_water (32-bit 

floating-point) 

  SUBDATASET_5_NAME=NETCDF:"PML_Namibia_MODIS_oc_refined_20090820135500.nc":Kd_490 

  SUBDATASET_5_DESC=[1x1557x1334] volume_attenuation_coefficient_of_downwelling_radiative_flux_in_sea_water 

(32-bit floating-point) 

  SUBDATASET_6_NAME=NETCDF:"PML_Namibia_MODIS_oc_refined_20090820135500.nc":nLw_531 

  SUBDATASET_6_DESC=[1x1557x1334] surface_upwelling_spectral_radiance_in_air_emerging_from_sea_water (32-bit 

floating-point) 

  SUBDATASET_7_NAME=NETCDF:"PML_Namibia_MODIS_oc_refined_20090820135500.nc":l2_flags 

  SUBDATASET_7_DESC=[1x1557x1334] l2_flags (16-bit integer) 

  SUBDATASET_8_NAME=NETCDF:"PML_Namibia_MODIS_oc_refined_20090820135500.nc":chlor_a 

  SUBDATASET_8_DESC=[1x1557x1334] mass_concentration_of_chlorophyll_a_in_sea_water (32-bit floating-point) 

  SUBDATASET_9_NAME=NETCDF:"PML_Namibia_MODIS_oc_refined_20090820135500.nc":nLw_443 

  SUBDATASET_9_DESC=[1x1557x1334] surface_upwelling_spectral_radiance_in_air_emerging_from_sea_water (32-bit 

floating-point) 

Corner Coordinates: 

Upper Left  (    0.0,    0.0) 

Lower Left  (    0.0,  512.0) 

Upper Right (  512.0,    0.0) 

Lower Right (  512.0,  512.0) 

Center      (  256.0,  256.0) 


